1 Instalacion en Ubuntu

1.1 Sumario

e 1 Introducion
e 2 Instalacion OpendDK
¢ 3 Instalacion do IDE Eclipse
+ 3.1 IDE Eclipse para tédolos usuarios
* 4 Instalacion Android SDK
+ 4.1 Android SDK para todolos usuarios
e 5 Instalacion plugin ADT
¢ 6 Librarias de 32 bits precisas para Ubuntu 13.10 Linux de 64 bits
e 7 Configuracion Eclipse e plugin ADT. Actualizaciéns
¢ 8 Carpetas de traballo
¢ 9 Fixar a icona ao Lanzador

1.2 Introducién

e Como xa se dixo, a versién de Ubuntu na que se elaborou o curso é a Ubuntu Desktop 13.10 de 64 bits. Tamén se probou na versién
Ubuntu Desktop 14.04 de 64 bits

¢ A razén de instalar cada comporiente por separado € que nos vai permitir ter un maior control de todo canto se precisa e ademais vai poder
permitir que cada lector instale os componentes que precise en funcion dos que xa ten instalados.

e Componentes:

O OpendDK (Java Development Kit), versién libre do JDK liderada por Oracle.

Como xa se indicou vaise instalar o JDK no canto do JRE (MV de Java), por se alguén desexa programar a maiores en Java en
consola ou con outros IDEs.

Nesta ocasion vaise facer uso de OpenJDK e non do JDK de Oracle, porque xa vén nos repositorios de Ubuntu.

Quen o desexe pode descargar o JDK orixinal de Oracle e instalalo seguindo os pasos:
http://www.oracle.com/technetwork/java/javase/downloads/index.html.

O IDE (Integrated Development Enviroment) de Eclipse.

O SDK (Software Development Kit) de Android

O ADT Plugin (Android Development Tools) para Eclipse. Permitira facer uso dende o IDE do SDK de Android.

* Quen desexe instalar todo isto en Ubuntu con entorno Unity e non se sinta con soltura no seu manexo, na parte Il do seguinte curso pode
observar como interactuar con Unity: Curso Platega: Ubuntu Desktop. Un sistema dual (MS Windows / GNU/Linux)

1.3 Instalacion OpendDK

e Vaise instalar a version 7.
e En http://openjdk.java.net pédese obter méis informacién sobre esta plataforma.

¢ Instalacion OpendDK
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P6dese marcar que se instale o paquete icedtea-X-plugin que € o plugin para os navegadores Web. Pero ...

.. vaise instalar dende o Terminal. Premer no botén de Inicio, procurar Terminal e lanzalo.
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Ladmingubase:-5 apt-cache search openidk

efsult-jdk - Stamdard Java or Java compatible Deweloprent Eit
[default-jdk-doc - Standard Java ar Jave compatible pevelopment kit (decumentatio
i
default-jre - Stamdard Java or Java compatible Rumtime
default-jre-headless - Standard Jave or Java compatible Runtlme (headless)
Logdtea:-T: jro: jamem = ALternative JVM for OpendDK, using JamiM

- weh browser plugin based on OpenlDK and IcedTea to exscute Ja

va applets
apanjok-T-de - OpendOK Developeent KLE {IDK) documentation
open jdik - T- jdk - DpendDE Deweloprent Kit il 4]
open jdk-7- jre - DpendDK Java runtime, wsing Motspot JIT

apen jok-7- jre-headless - DpendDK Java runtime, using Hotspat JIT (headless)
open jdik-7- jre-Lik - OpendDE Java rntime (architecture independent Libraries)
open jdk-7-scurce - OpendDE Development KLt (J0K) source Files

apen jdi-T-dbg - Java runtime based on Openlix (debugging symbals)
open]dik-7-demo - Java runtime based on OpenlOK (demos and examples)

javs-package - Utility for creating Java Debiam packsges

freealnd - lava Program for creating and viewimg Mindmaps

Lcedtea-&- Jre-cacad - Alternative JWM for CpendDK, using Cacad

Con apt-cache search openjdk vense os paquetes disponibles. Entre eles, o mendionado icedtea-X-plugin e o metapaquete default-jdk,
que sempre vai instalar a version mais recente do JDK de OpenJDK.
(3 © ladmin@ubas

ladningubase:~5 sudo apt-get install default-jdk icedtea-7-plugin
[sudo] password for ladmin: [}

Executar sudo apt-get install default-jdk icedtea-7-plugin para instalar os dous paquetes.

apenjdk-7- jre openidk-T-jre-headless openjdk-T-ire-1ib trdata- java

Ellprota-core-dev xllproto-input-dey allproto-kb-dey xorg-sgml-dectocls

ETrans -day

Paquetes suxeridos:
equive Libbonsbo?-bin desktop-base LibgnomevTs?-bin Libghomevfs?-extra gamin
fam gnome-=mime:data Libilce-doc Uibsm-doc libuxchb:doc 1ibat-doc epenidk:7-demo
openjdk:7-source visualvm sun-javaé-fonts fonts.ipafont-gothic
fonts-ipafont-malncho ttf-telugu-fonts ttf-oriya-fonts ttf-kamnada-fonts
ttf-bengali-fonts

0s seguintes paguetes NOWOS hanse instalar:
ca-certificates- java default-jdk default-jre defawlt-jre-headless
Fonts-dejavu-extra lcedtea-7-jre-jarmvm lcedtea-T-plugln Lcedtes-netx
Leediea-netx-common Java-comman Tibatk-wrapper-java LTibatk-wrapper-java- jnl
Likbenobe2-8 Likbohobol -cormen Libgcant2-4 Tibghif4 Likgnore? -8 Tibgheme?-bBin
Libgmome? - common Libgnemevls?2 -8 Tibgnomevrs? -comman Tiblce-dey 11b1d1-comman
Libidlg 1iborbit? 1ibpthread-stubsd Libpthread-stubsl-dev Libsm-dav
Libxil-dev Uibwil-doc Libxau-dew Libxchi-dev Llbwdmcp-dev Uibut-dev
apenidk-7- 1dk openjdk-7-jre openjdk-T-jre-headless openjdk-7-jre-Lib
tzdata- java xillproto-core-dev xllproto- input-dev xilproto-kb-dev
xorg-sgnl-doctools wtrans-dew

0 anovedos, 44 Lnstalades, Vanse retirar @ e delzar 11 sen anowar.

Tem gue reclblr 67,1 M8 de arquivos,

Despois desta operaclén ocuparanse 113 M8 de disce adlclonals,

guere cantinuar [5/n]? [l

Informacién sobre o que se vai instalar. Indicar que Si se desexa continuar.

Ladminfubase: -

ladnin@ubase:~5% javac -versien

jawac 1.7.8_25

Ladmingubase: -5 java -wersilon

jawva version "1.7.8_25"

Dpen]DK Runtime Environment {(IcedTea 2.3.12) (Tuz5:2.3.12-4ubuntui)
Openl¥ &4-Blt Server WH (bulld 23.7-b81, mixed mode)
lLadmningubase: -5

Comprobacion das versions do compilador de Java (javac -version) e da MV de Java (JRE) (java -version).

1.4 Instalacion do IDE Eclipse

¢ A continuacién instalarase o IDE de Eclipse, cuxo proceso de instalacion é simplemente descargar e descomprimir un paquete, sen mais.
¢ En hitp:/eclipse.org/ estéa o sitio do IDE.

¢ Instalacion IDE Eclipse
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En hitp://www.eclipse.org/downloads/ podemos atopar a Gltima version. A imaxe amosa a version 4.3.1. Na actualiadade é a 4.4.1. Neste
caso descargase a version de 64 bits do IDE de Java EE (Enterprise Edition) por ser mais completa ca do IDE de Java, pero con esta Ultima
tamén seria suficiente. Cada quen que baixe a versiéon de 64 ou 32 bits en funcién do seu S.O.
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ladningubase:-$ cd Descargas/
Ladnin@ubase: - /Descargas$ tar

xf eclipse-jee-kepler-SRi-linux-gtk -x86_64.tar.gz

Tamahio
O Recentes
M Cartalel persoal
[ Escritorio

| edlipsejee-kepler-5A1-Gnux-gtk-wio_g4t. ..

eclipse
Luganes Home = Tamadie
) recerkes ‘ ahaut_files 4 elementas
e ‘ configuration 3 plementos
& Escritaria
& Descargas ‘ drapins Delementos
[ Documentes ‘ Features 155 elementas
B Imaxes 5 - i
B Blementos
44 Misica ‘
H videas [l plugins 821 slementas
& Lixo il readme 1 elements
Disposithvos
2 abauthtml 18,7 kiBy
BLDn" putador
artifacts aml 245,0kiB
Rede %
& Explorar & rede 'G eclipse T30kl
O conectarse a unse.... eclipse.ini 344 bytes
eplv10.hibmi 16.5kiB
!.{nr Apm SOkiB

.. para traballar. Facer dobre click sobre o executable (asegurarse que tefia permisos de execucién).
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Abrindose o IDE. Versién da imaxe: 4.3.1 (Kepler). Imaxe actual 4.4.1 (Luna)

Select a workspace

Eclipse stores your projects ina Molder called a workspace.
Choose a workspace folder to use For this session
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1.4.1 IDE Eclipse para tédolos usuarios

¢ Para que o IDE Eclipse estea dispofible para tédolos usuarios do sistema, s6 é preciso pofier o cartafol Eclipse nunha ruta accesible por
todo usuario. Neste caso vaise facer uso da mais recomendada /opt/eclipse.

¢ Logo s6 resta axustar o propietario e os permisos do cartafol.

¢ Pddese facer todo isto dende o contorno gréafico pero vaise realizar dende a consola con sudo.

e Finalmente crearase un menu para que calquera usuario poida lanzar o IDE dende o Botén de Inicio do Lanzador.

¢ Instalacién IDE Eclipse para tédolos usuarios
-

y ladmin@ubase: ~

ladmin@ubase:~S sudo mv Descargas/eclipse /opt/
[sudo] password for ladmin:
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Mover o cartafol eclipse: sudo mv Descargas/eclipse /opt/

ladmin@ubase:-% sude chown reot:root fopt/eclipse -R
ladmin@ubase:~%

ladmingubase:~% sudo chmod 755 fopt/eclipse/ -R
ladmingubase:~%

Cambiar o usuario e o grupo propietario dese cartafol e o seu contido: sudo chown root:root /opt/eclipse -R

ladmingubase:~% sudo chown root:root fopt/eclipse -R
ladmin@ubase:~%

ladmingubase:~% sudo chmod 755 foptfeclipse/ -R
ladmingubase:~5%

Dar permisos de control total ao propietario, aos demais usuarios de lectura e execucién para ese cartafol e todo o seu contido: sudo chmod
755 /opt/eclipse -R

eclipse

Lugares EEI' Homa +  Tamafia Tipo
@ Recentes ‘ -él."'ﬁ.l(__:' Lot d4 elementos Cartafol
MW Cartafol persoal A
‘ canfiguration Belementos Cartafol
[ Escritorio
& Descargas Wl dropins Delementos Cartafol
D) pocumentos i features 155 elementos  Cartafol
I Imaes i I e
: p2 Zelementos  Cartafol
& Misica ‘
H videos ' pluging BX3elementos Cartafiol
& Lixo ] readme 1elemento Cartafol
Dispositivas
abouhtmd 18,7 kiB Texto
Computadar
artifacts. xml 240.0klB Marcado
Rede
¥ Explorar a rede {:3’ edipse 73,0kiB Programa
B conectarse aunse... edlipse.ini 444 bytes Texto
eplv10.heml 16,5 kB Texkto
- IEan.kpm GOKIB Imaxe

Un usuario normal poderia ir ao cartafol /opt/eclipse e lanzar o IDE, pero mellor crear un mend.

ladming@ubase:-$S sudo gedit fusr/share/applications/Eclipse.desktop

Para iso hai que crear un lanzador (extension desktop) en /usr/share/applications. Nese directorio estan os lanzadores (menus) das demais
aplicaciéns. Para iso creamos o ficheiro con gedit e executdmolo como root: sudo gedit /usr/share/applications/Eclipse.desktop

€ *Eclipse.desktop (fusrfsharefapplications) - gedit

Editar Buscar Ferramentas DoCume

=, Desl:

i *Eclipse.desktop X

[pesktop Entry]

Type=Application

Name=Eclipse

Comment=Eclipse Integrated Development Environment
Exec=env UBUNTU_MENUPROXY= foptfeclipse/eclipse

I:[cnn:l."crptfec lipse/icon.xpm
Categories= :IDE; Java;

Pegamos o contido que se amosa dias imaxes mais abaixo, modificando as rutas se fose o caso.
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fii Aplicativos

Se agora se preme no boton Inicio xa se ve o Lanzador de Eclipse.

ladmin@ubase: ~
ladmin@ubase:~$ sudo fopt/eclipse/eclipsel}

Tamén se pode lanzar Eclipse dende a consola. Como root hai que usar o comando sudo, como usuario normal sen sudo.

[Desktop Entry]

Type=Application

Name=Eclipse

Comment=Eclipse Integrated Development Enviroment
Exec=env UBUNTU_MENUPROXY= /opt/eclipse/eclipse
Icon=/opt/eclipse/icon.xpm

Categories=Development; IDE; Java;

NOTA: Na version 13.10 de Ubuntu se non se engade en Exec env UBUNTU_MENUPROXY non se amosarian os menus da aplicacion.

1.5 Instalacion Android SDK

¢ O proceso de instalacion é semellante ao do IDE Eclipse: descargar un paquete e descomprimilo.
¢ En hitp://developer.android.com/sdk/index.html#Other podemos comezar co proceso de instalacién.
¢ Poderiamos descargar o Bundle asociado ao noso SO e este xa traeria integrado nun sé paquete: Eclipse + Android SDK + Plugin ADT. S6
restaria instalar o JRE (ou JDK se se desexa).
+ Poderiase configurar para que puidera ser usado por calquera usuario do sistema do mesmo xeito que se fixo antes con Eclipse e
que se vai facer a continuacion co SDK de Android.
¢ Pero, como indicamos, vaise instalar cada compofiente por separado.

¢ Instalacion Android SDK
SOF Toois Only

L[]
e P I3
FYTTRLFo Se—

ndad Lo

En http://developer.android.com/sdk/index.html#Other poderemos descargar o SDK para Android. asociado ao noso SO. Neste caso
baixarase o SDK para Linux, fixarse que a versién é a mesma para 32 bits que para 64 bits, co cal é probable que nas versiéons do SO de 64
bits haxa que instalar librarias de 32 bits que precisen os compofientes do SDK para ser executadas.
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™ Cartalol persoal

Lugares
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arge,
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B Escritorio =

[ pocumentos
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| Lixo
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Computador
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¥ Explorar a rede
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Descomprimimos o ficheiro. En modo grafico ...

ladmin@ubase: ~/Descargas

ladningubase:~S cd Descargas/

Ladningubase:~/Descargas$

ladnin@ubase:-/Descargas$ tar -xf android-sdk_r22.2.1-1inux.tgz
ladningubase:~/Descargass l

... OU por consola.

» Agora xa teriamos unha carpeta co SDK, da que poderia facer uso o usuario actual pero non todos os demais do sistema.
» Por tanto, igual que se fixo antes con Eclipse para configuralo para tédolos usuarios, vaise proceder agora c6 SDK de Android.

1.5.1 Android SDK para todolos usuarios

¢ lgual que antes: pofier o0 SDK nunha ruta accesible para tdédolos usuarios do sistema: /opt/android-sdk-linux.
¢ Logo s6 resta axustar o propietario e os permisos do cartafol.
» Pédese facer todo isto dende o contorno grafico pero vaise realizar dende a consola con sudo.

¢ Instalacion Android SDK para tédolos usuarios

ladmin@ubase: ~

ladmin@ubase:~S sudo mv Descargas/android-sdk-1linux/ fopt/
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Mover o SDK: sudo mv Descargas/android-sdk-linux /opt/

. EL ubase: ~

Ladmingubase:~5 sudo chown reot:root fopt/android-sdk-linux/ -R
Ladmingubase:~5

Ladmingubase:~5 sudo chmod 755 foptfandroid-sdk-linux/ -R
Ladmingubase:~5

Axustar os propietarios do cartafol e o seu contido: sudo chown root:root /opt/android-sdk-linux -R

Ladmingubase:~5 sudo chown reot:root fopt/android-sdk-Llinux/ -R
Ladmingubase:~5

ladmingubase:~5 sudo chmod 755 foptfandroid-sdk-1linux/ -R
Ladmingubase:~5

Axustar os permisos ... sudo chmod 755 /opt/android-sdk-linux -R

andrald-sdk-limu

B opt android-sdi-
13
Lagares PG =  Tamafhs
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[ Escritorio
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[ bocumentos il toals 52 elemenbos

B Imaxes . SOK Readme. o 1,2kiB

‘ platferms Delementas

O contido do cartafol /opt/android-sdk-linux
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O contido do subcartafol tools. Hai un programa chamado android que permite, entre outras cousas, xestionar as APIs do SDK e os
emuladores de dispositivos.

L] _
admingubaze! -3 sudo fopt/androld- sdi- Ui/ ooeols feasdrald - -help

Usage!
androld [global optlons] actlon [actlon optloms]
Clobal optlons!
-h --h&lp ! Help gn & specific Command.
-w - -yerbose 1 VerboSe mode, shows errors, swarobegs and all ressages.
--clear-cache: Clear the SDE Mansger repository mealfest cache.
-5 --sllent r 5ilent mode, shows errors only.
Walild
actions
are
corposed
of a verb
and an
optional
direct
ohiect:
- 2k i Displays the 50X Mansger wirdow
- avtd i Displays the M Monsger window .
- st : Liste existing tergets or wirtwsl dewices,
- st awd i Lists exisking Andrald virtwsl Devices.
- list target ; Liste existing targets.
- Wt adk i Ligts remote 50K repository.
- create avd : Creates a new Androbd virtesl pevice.
- e aud : Hovep ar rensses an &ndrold wirtesl Device.
- delete awd i Deletes an Andrald Wiftusl Devlce.
- update awd : Updates an Androld wirtusl Device te match the Tolders
af & hiw 50K,
- EfEale project { Creates a new Androld project.
- update project ¢ Updates an Andrald project (meit already have an
Androtdianifest.oml].
- EFeate TOST-project @ Croates a niw Andrald preaject Ter a test package.
- updats Tiit-ﬁfﬁ:il:'l ¢ Updates the Andrald hl’ﬁ]ﬁl far & tait HCkiI]i {Rust
already have an sndrolomanl fest aml).
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Podemos executalo dende a consola, indicando a sla ruta. Con sudo é executado como root, e sen sudo como un usuario normal.
/opt/android-sdk-linux/tools/android --help.

ladningubase:~$ sudo fopt/androild-sdk-1linux/tools/androld sdk

Como imos actualizar as APIs do SDK e descargar os seus compofientes € preciso lanzar o Xestor do SDK (SDK Manager) como root:
sudo /opt/android-sdk-linux/tools/android sdk. A opcién sdk é a que se usa por defecto cando non se indica ningunha.

P e e e
o
s A P yrraa ammsry ai i | A

o ‘el g e e

Se se preme na imaxe verase en tamano real, e podera apreciarse, que ainda non estéd o SDK listo para poder crear o noso primeiro
programa: precisanse compofientes que xa marca por defecto o xestor: Unha API (marca por defecto as ultimas, a 5.1.1 e M) e compofientes
béasicos (na imaxe vefien marcadas outras por ser unha version anterior).

T Ui M bl Tk G il T B g
Dhdmte [

Chow=

Neste caso, como xa se indicou nun apartado anterior, vanse descargar a AP| 16 asociada & version de Android 4.1.2 e se desexa as 5.1.1 e
M. Lembrar que estas duas Ultimas APIS ocupan uns 6 GiB.
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Packages
¥ o Android S0K Licerse

Pt kg Dascriglion k License
Packages

" Bndroid SO Patfarm-tools, e
" Android S0 Bulld-toods, resish
+" Documentation for Android SO
+ SDHC Platfoem Android 4.3, AR

+" SDE Platform Android 4.1.2. AF
" 50K Plaafoem andrald 4.0.3, AF
& SN Plagfeem andnaid 20,5 AF
+" Samples far S0K AP 18, (edsia
" Samplas hor SDHCAPY 18, revdsia

- Arddrowd SDE Platform-tools, revision 18001

- syrciroid S04 Bulld-bools, revision TE.1.1

- Documentation for Android SDE, AP 18, revision 2

- 50k Flathorm &ndrodd 4.3, AP 18, resision 2

- SO Platharm Android 4.1.2, AP 16, revésion 4
i Fathorm Androdd 4.0.3, AP 15, revision 3
0k Platfarm Androdd 2.3.3, AP1 10, revizion 2
Samples For 50K AP 18, revision 1

- Eamephis For S0K AP 16, revision 1

- Sarmeples For S0K AP| 45, revision }

< gk Fior S0K AP 10, rewision 1

- AR EAR 4T Sysbem image, Android AP 1A, revion

- AR EABwTa System image, Android AR 16, redsion ¥
- AEEE A Ty TP e by A ndeald ADIVE rasdrlas B

Copyto chigboard |
Print

~ Samples for SDK AP 15, nevisio
« Samples for SDK AP 140, revisio

" AR EABI vTa Sysbem Image, & - Q}mwt License

Cancel

L

Aceptar as licencias dos compofentes.

Fackages
" Googhe AP, Andrald AP 10, e -
 Sources for Android S0, AP 1
«" Soirces For Androld SDE, AP|1
" Sparces For Android S0E, AP 1
«" aindroid Support Library, revisi

¥ o Inbel Ardnoid Sysimage Licenss
' Intel xBE Atom System Image, £
= Inbel xBS Abom Sysbem Image, £
= Inbel S Al Sylbem IMage, £
+F Intel K08 Alam Syt image, £

¥ o MIPS Aralicid Synimage Licinss
= MIPS Sytiem mage, Android A

Pt kg Dascriglion k License

Packages

= MIPS Sysbem Image, Ascnoid &F1 16, revsion 4
- MIPS System Image, Ardrodd AF1 15, revision |

License

AIPS Technologies, bnc CMIFST) Internal Evaluation
License Agresment for MIFS Andrebd™ System Images for
Androdd Softeane Deselepmient KIL (SDE]

This internal Bvaluation License Agreement (this
TAQIEEMENt”) |5 entered inte by and Betwaen MIPS ard
yau fas an individual deveboper o & lsgal entity
idenlild helow ag "Rocipiant”), el chall maks tha
Evaluation Software sailable to Recipient as described in
FEEordance with the terms and conditions set Porth

Bl

Copyhbo chighoard
+ MIPS System kmage, Android A L cheboard | g ccapt Licenss
Caneel oo dnatall o

Ollo!!! que abaixo hai mais licencias para aceptar. E premer en Install

T L T gy ey T b e ———
Farse XML https:idl-ssl.google.com/android freposit oryfsys-img /86 sys-img.om|
Found Inbel 488 At Systam Image, Ardraid AP 10, ravision 2
Found Intel x88 Atom Sy tem image, Android AP 15, revision 1
Found Intel 86 Atom System Image, Android AP 16, revision 1
Found Intel xi8& At System image, Andraid AP 1T, revision 1
Found Intel zB8 Akom System image, Androld APY 18, revidion 1
Done loading packages.
Braparing b install archives
Downloading Aundrold S0K Platform-tools, resfision 18001
Imstalling Androld SDE Platform-tools, revision 1801
Stopping ADE server aflad feode -1).
Installed Androéd S0 Platform-tols, revision 1800
lnwrll-ulu-g androld SDK Bulld-tools, revision 18.1.1

Downloading Android S0 Build-tools, revision 1817 {28%, 1129 Kily's, 12 secands left} Close

Comezo da descarga. Da un erro de que non pode parar o servidor ADB. Este compofiente verase nun apartado posterior.
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Tl kb

Fuckagus
i Marrs AP Rex Slabui .
¢ APRAT HEM BMAHGEEE rapr AT R ERT
+ Atk SO Buakd-Daeds " i el
Wi I'Ard'ﬂ'd ll'ﬁ |ii
—_— -
Giuwn lgding Lamples far S0K AR 18, revishn 1

installify Saenples P S0 &P 18, revigon 1
iratslled Samipdes Por S0 AP 1R, redglen 1

Dewamn loading Sam, Far SOE AR S8, revinien 1
installiag Samplas foe SDK AP 16, revisian 1
IrnLilled Sanpdes For SOE. AP 18, rirdsiben 1
Diownleading Sampled far SOK AP 18, reviilen 2
mstallisg 3emples for 30K AP 13, revishan 2
irsballed Samples Por 508 AP 15, resshon 2
Bownlosding tamples far S0k &8 18, revilen 1
ingralliag fsmplee Por SO0 &P 10, rewicion
irsballed Samples For S0 AR 10, resnion 1

Down losding Scurcen For Aadrold S0K, AR tl, evidon 1

Dol crireg Soeries Fov andredd S0 AP 18, revidon 1 (25w, 950 KiEM, 15 seosnds Left] Chase
T RO E Y e Ty T T
*  E3 Androd 2780 B
* [ Ardrmid 21060 T
L Ashabrovid 1.6 48 &

Show [l UpdstesMew il iretalled Ohiplene Selwct Hew o Updates
maiby @ AP Aepraitary D idict 40
— e
o B

Dzabiad e Laiw ped Mo andiok] SOK, AP OE, redshan 1 [, SE0RBfc. 15 seoards k)

Contintia a descarga.

S Pk b

& Plarrs
# ANATaID SLK B 0nsa R CRRE R T ]
4 Al SN Buil-

nloading Google &P, & ndveld &P 13 evidon &
installiag danghe dFis. dndrold 48 15, evigion &
iratalled Google AP, Ancenid AP 15, redsien

Drown losding Cotgle AP, Andreid AP 10, revidan T
installing Google AR, Androld AR 8, revision I
IrmLadled Coogle &P, Andiosd AP0, reres
Ly clabind] ADS LS up@aiL L USE dewiid deflared o e 50K dddam.

SLepping ADE server Talled fade 1)

unatal e U e el b'] CarRaL P g ae " o el v b L e o T v ik B ™
#rvadal, Hos hal bal Reksbe oo drgctoris,

RERrEIng ADE paraar Palad oo -]

Bione. 18 packages Inctalled.

Done lasding packager.

Dottt | ndn ] P i Chase
TN THEET T R DT Sy T [P T ™ T |I9 PR
il MIPS rmben Imege s L] = imtalled
-:-l'nng.-n‘-P: id i | sgalled
T Sources for Anchid S0w 4 i | nstelled
N P PR
show: [l Updstesew Il imsialled Ohsplete Select Wew or Updates
mart b @ AP Repraibary Dt &1
0 o

Guaree laddingpachages
Erro de que non pode iniciar o servidor ADB, e isto si que é un problema. Isto pasa nas versién de 64 bits de Ubuntu 13.10, porque para
iniciarse ese servidor precisa unhas librarias de 32 bits que non estan instaladas. Logo arranxarase.
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10 T retaled
o 1 = IrmLaled
= Cs andvsdd Liiam 7
" La Andirsid 1.2 (AP14)
b = Andriodd 1.5 (AP 3]
™ Exlras
E3 Anthoed Seppart S oy 2 Fol smfaked
& Ardoid Supgor id & imbaled
0 Coagh A 4 11 WOE NHrald
B Coagle Assiptics Asp Frocking SO0 i | Net kribalied
B (Deprretesl Coogle Cloud Mempoing fer A4 ] Wot kuralied
3 Googhe PATY RMASEE F wor e
£ Coogle RestuAlony 3 Mot sulalind
B Coagle Pley A% Faponmian {brony ] o dnrralied
0O Googhe Phoy Sl Eikvoy L wot hurabed
B Coaghs Moy Liveing Ll 2 Nt brifakd
E3 Cooghe LSSE Dmweer ] Nof campot e waTh Linay
O Googht wed Briver F 3 Aot krralied
E3 i 687 Erianitar Adcmimodor (AN 3 Nor campotiieh wiTA Livian
shaw. [ Updebeshiew Bl nagalled Heaalete Sebect Mew o0 Updatis
St b B AR lewel Rrpstknry D scie all

Donine Loy obire] peackaipes

Componentes do SDK instalados.

ol android-sdk=linux

android-sdk-linux

Lugares Home v Tamaf
@ Recentes il add-ons 4 elementos
N rﬁ”jﬁrollpﬂmdl ‘ build-toals 1 Elemento
[ Escritorio
& Descargas ll docs 35 elementos
D Documentos  ctras 1 elemento
B Imaxes —_— ey
43 Misica d platfarms. 4 glementos
H videss il Platform-tools & elementos
i Lixa ol = ples 4 elementos

Dispositivos ;

d sowrces 1 Elemenlos
Computador _ .

e Wl fyetem-images 4 clementos
& Explorar a rede al teme 0 elementos
B conectarsea unse... il boals 12 elementos

50K Readme. txt 1.2kiB

Carpetas creadas e asociadas ao SDK.

NOTA:: Cando decidimos instalar unha nova versién do S.O. Android non é necesario marcar todas as opciéns dentro desta API. Asi:

¢ SDK: Necesario para poder desenvolver a aplicacién. Sempre debe ser marcada.

¢ Samples for SDK: Documentacion de exemplo. Non é necesario marcala.

¢ System Image (ARM/Intel/MIPS): Cando mais adiante utilicemos un dispositivo virtual para correr as nosas aplicacions, sera
necesario ter descargado a lo menos unha destas imaxes. O normal é que se temos un procesador INTEL descarguemos unha
imaxe INTEL xa que despois poderemos instalar un acelerador hardware para dito micro. Se non temos intel poderiamos
descargar calquera das opcions.

¢ Google API: O mesmo que o System Image pero para dar soporte a aplicaciéons que van facer uso de Google Maps. Se non imos
traballar con el non seré necesario descargalas.

¢ Sources for Android SDK: Fontes das funciéns do SDK. Non é necesario descargalas.

1.6 Instalacion plugin ADT

¢ S6 resta instalar o plugin en Eclipse que permita traballar dende este IDE co SDK de Android.
¢ Este plugin chamase: Android Development Tools (ADT) e estende as capacidades de Eclipse para xestionar dispositivos méviles
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(emulados e reais), compilar e instalar aplicaciéns en dispositivos, etc.
¢ En http://developer.android.com/tools/sdk/eclipse-adt.html hai mais informacién sobre este compofiente e como se pode instalar no IDE.

e |nstalacion ADT Plugin

S D

£ & g faim - (M- L+ I "
W Develiapens D roudzy Diaribira Rl
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REvisiinng
En http://developer.android.com/tools/sdk/eclipse-adt.html premer en Installing the Eclipse Plugin
o | Download the ADT Plugin

Sail Ecipie, 1Ren délend Help - Ingall Neas Saftvain
ik Add. in The top-right comer.
In it Add Repositony dialog that appears, antes ADT Plugn® for the Mame and the bl lowing LIL for the Location

B

hitps: fadl- 551 gomgle. comfandroid e Lipses

Chok QK

¥ you hawe trouble acquising the plugin, Sry using Titp” in the Location URL, instead of Bitps” (hips is prefermed foe
seruTity measons).

In ik Availatle Sottwane delog, sshect the chedkbox neet 1o Developer Tools and chick Mest

fin Thez niexct w o, Yo s o 115 od the Tools 1o be Sownloaded. Click Mext.

Aend and accept thelicense agresmens, then ol Finish

B you gel & security waming saying that ihe auihenticiy o validay of the softmore cant be exiablished, click OF
A. 'Whin th installati gletes, restant Edlipse.

En http://developer.android.com/sdk/installing/installing-adt.html indica que podemos instalar o Plugin de dias formas:
Troubleshoating ADT Installation

ot o

1T youare hesing trautibe downbsading 1he SDT pluginafte Tollowing the sieps shave, here 4re some suggesiions

= H Eclipese can i find the remate updabe ste compining the ADT plugn, toy changing the rerote st UAL 2 use iR,
rafber Tan hitips. Thal s, 5=t the Location for the remate she doc

Witp sedl 551 poog e oond andraddseclipses
= o aie befained m Tewa B {mach st i corparite iimmalll make suse thal you beres oy csnfguned yoer proey

weitingrinEripee. |- Eckpse prony from fhe madn Eclipss mesy in Window [on Mac 05
¥ Eclpsei r Frelmences - General = m:m

1T ot i Lnibiba 1o s Echipes 10 dawnload the ADT plugin an s semots updals wle, pou can dowsload the ADT big
ke I o Inscal mach ime ard manualy mudsl il

1. Dessidoad the DT Plagin 2ip Sle (do sl unpas il)

AR op 14474 bryen ATITETEAn ol bl oSl S04k T Bl

Hierd letglhmﬁmlﬂ-mlmm

DCiick Add in the Lop-right corner.

it Add Repcediony dislog, cick Archies

Gt the downleaded S0F22 2.1 2p Nie snd Aok OK.

Ermied "ADT Phegin” Mo thie name ard clack DK

e P A Lt be Sioftwn s kg uelect | chackisere seal 1z vl i Tonlnard sk Wt

I thee et sindaw, youtl see s of the doals b ke downkaded Click Nt

Resid el SCoept (he Boefiss BYiEiem . Wen dick Fislsh

W yena gl i dsinily wiaiting srywig Tl Lhe il benlicity of vali iy of B saltmi i nt b salabiahed, di ch O,
0l When the instalaiion compleies. resiart Edliger

-

Tor st it plhogin cnes yoa'w i redla D ing B B Tk, you will Risve s islam e g sgain ingled of e
elnnit updnde

Unha descargando o paquete e logo instalalo dende Eclipse ...
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Download the ADT Plugin

Etart Eclipss, ihen sel it Help > Insiall Bew Soliman:
Click Asd, in the top-right coimen
s e A Feeaibny chidlong Thal Bppeaes, #ntir "ADT Plugin® for the Name and this tollowing LFL tor the Locstian

[T

o

. ok R
¥ vou have trouble soquining The phugs
secutity reanor]
It Avaiable Soltware dalog, el
By B e wincowy, pong)l s i liw a1 rlarcer £33 lgaen

gz iin nunha revss lapela
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=1 o

Fieaxd and sccep) e Bosrae ageeemen Cardar ligards coma..

1 yiru g A SRCURITY Wil ng) diying Ihm b b, ik OHE.
Selecchear bodo

=

‘Wil ha inslallaton comgleey rsta
’ Bescar “hitps/fidissl... * en Google

Configure the ADT Plugin ver & codigo da seleccian

nspecciones el emento

... OU copiar o enlace ao repositorio no que se atopa o plugin ADT: https://dl-ssl.google.com/android/eclipse/. Usaremos esta forma.

ladmin@ubase:~$ sudo /Jopt/eclipse/eclipse

Lanzar eclipse como root.

B welome & wieloome

Felp Conlans
o Eclipse Java EE IDE for Web Develop el
Saaich

Cafdimic Hegn

Eey Ansist..
Tips and Tricks...
Report Bug or Enhancement...

Cheat Sheets...
ey Ecliget i Markitplace £
j;:} ek For Upsdates &
ut Eclipse
bt Eclipss 5
Premer en Help -> Install New Software...
L[]
sivaliabin Software I
Salih A &lbe oF ardel the lasatianof & ke =] -

work with: |nibtps/felsslgoaghe.comyandraldfeclipse)

Finid mare software biy warking with the

LEL ] VETsion

(@) There 5 mo sike selectbed

Seleil all Dmalict A0
Pslaibs
I shew aaly the latest versiam of avalla bl saftwide B Hide it Chail sl ol i dy bk Ll lied
B Group Ibems by categary wihat is piready installed?

Show oely software appliceble bo target emaron=ant

W Contact all vpdate sibes during install ko find required sofbwane

? e Cancal

Pegar o repositorio ... Premer en Add.

Mame: |.ADT | Local...
Location: | MEps.//di-ssl.google.com/android/feclipse/ archive.,.
i) Cancel 0K
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Pofer un nome ao repositorio, neste caso ADT.

Available Software
et

Check the mema that you wish to install.

iark with: | ADT - hibps:)fdi-ssl googhe comfandraid/eclipse/
Find more salbware by warking with the "ovailable Soltwasre Sites”

Hame WET SO
k@ 0 Devitloper Toals
» 01 MDK Pluging

O Selecball || Deselectall i itemd selecied
Amosa os compofientes que se van instalar. Na uUltima versién do ADT s6 hai un compofiente. O compofiente NDK: Native Development Kit

era para desenvolver aplicacions en linguaxe nativa como C ou C++. Mais informacién: http://developer.android.com/tools/sdk/ndk/index.html

L]
Available Software
2 -

Check the mema that you wish to install

Wiark weth: | ADT - hitps/Mdl-sil googke. tomfand ral declipse) T Add
Find more soltware by working with the ovaileble Soltwere Sites”
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« %1 Androld DOMS " 221520130016
W & Android Development Toods 2.2 1,300 30810
B 4 Android Hierarchy Viesser 22.2.1.420M209181
Select all Deselect Al Gitems seleched
Dentro dos compofientes de Developer Tools hai outros como DDMS que se vera nun apartado posterior.
L]
Avalabie Soltwars
Check the ibersa Ehat you aishiEn insbal -r
Workwith: | A0T - hebpssfdbssl geagie com fard retdfeclipe . Add
Fared oo Lo Dl i By v Thoing with the “awai labie SofTwais Sipes
Mame Verdon

& "% Dyerloper Toolh
® SR NDE Magits
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Dot i b
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Show oy waftmare sppbcakleEn barget sredronment

B contao all ussdute sibes during losLall to fird regquired sofoware

Ly . Mt B Carcel

Unha vez marcado todo premer en Next.
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4 Argdraid Traceview
o Tracer for OpenGL E5

Sizes Unknown
Dotz

Cancel

g
L
E

Premer en Next.

Rewiew Licenses

X il
Liserded miudlk be feviewed and sciepled Befcde 1he Lol twaie (an be matalled ¥-1 =

Licenses: License ext

Apwche Licpras Mipache Licerse

= Wersion 2.0, Jsrwary 2004

" r =

Eclipse Foundation Scftware User Syeement httpclwesenapache. olice s s
¥ Eclipse Public License-v 1.0

Note: jcommean1.0.12 jar is under the BSD license rather H;gg;ﬂﬁﬁﬂggﬁ;@i;ﬁ;ﬂ
Moke: kxmi2-2. 00, sr is under the BSD Boerae rather ther i >

-
1. Defindticere:

“License” shall mean the terme and conditions
ke, reproduction,

wnd dirkrdoeiee v Arflead b Cnrkinee € Paras
@ | acoept the berma of the Boerse agreements

| gho not accept the tenms of the licerse agres

.

] « Back ' cancel | [ Finkshs

Aceptar a licencia.

0 Installing Software

Felching com.android.ide eclipse hierarchy.-. luging/ (301, 93%B of 383,298 at 128kB/)

Always run in background

installing Software
S ———

Installing Software: Fetching com.and._f (T9.37kB of 383.3%k8 at 7TE.01kE/s)

Cancel hum.s Run in Backgrouwnd

Proceso de descarga e instalacion dos paquetes.

priky

warning: vou are installing sofvaare that contains unsighed cantent. The
o autherticity or validity of this software cannok be established. Do you want to

conkinue with the installation?

| ok t Y | Details =» cancel
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Aceptar a advertencia que indica que hai software sen asinar.

You will need to restart Eclipse for the changes to take effect. Would you like
e o restark now?

Ho i m b

Reiniciar eclipse cando remate a instalacion do plugin.

Weliama o Ardraid “UHI'.IFIM"'II
Canfigure SDK !

oo demedionpy Frowr Ao, o need an Android SIDF, and at leest oee wersion of Hhe Ardroed
APls bo compdle against. You may also want sdditional vershors of Andeoed bo besk with

@ intall pew SDK

o oo |
ratall A

(i Cadh 3 — Locatiomal Ehi Ardraid SDK has nol Been ebop in Che preferanoss
Target Lacat] a
Use eninting] Gpen Preleences Coae h.
Existing Loca
? BEsta | | cancel

Advertencia que indica que non se atopa a ruta do SDK de Android. Pechar.

come bto Androld Development

Welcome to Android Developmaent
Configure 50K

To develop lor Android, you need an Androkd S0, and at leash one version of the Android
APIs to compdle against. You may alsowant additional versions of Android bo best with

Inskall rewe SDK
B nstall the latest avallable version of Androld APls (supports all the labest features)
install android 2.2, a version which is supported by ~96% phones and tablets

{¥Youcan add additional platforms using the SDK Manager.)

Target Location

@ Use existing SDEs

Existing Location: | fopt/android-sdi-lnux Browse..,

i : MExt = Cancel
' L

Unha vez instalado o Plugin ADT en Eclipse este permitenos que instalemos un novo SDK de Android descargandoo dende cero, ou usar un
xa instalado. Escoller esta segunda opcién e indicar a ruta /opt/android-sdk-linux
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Welcome to Android Development

Contribute Usage Statistics? ’
I
we know you just want to get started but please read this First. "‘

By choosing to send certain usage statistics [o Google, you can help us improve the
Androéd S0 These usage statiskics bets us measure things like active usage of the
SDE, and let us know things ke which versions of the SDK are in use and which tools
are the mast popular with dewelopers, This limited data is not associabed with
perzonalinfermation about you, and is examined o an aggregate basis, and is
mairtained in accordance with the Google Privacy Podicy,

Send usape stakistics to Google?
s

@ ol

If wou kater decide to change this setting, you can do 50 in the options panel under
Androdd > Usage Staks

Coogle Privacy

? = Back Cancel " fhiihh‘

Indicar se se desexa participar nas estadisticas de Google.

Unexpected exception 'Cannol run program "lopl/android-sdk-linus/platlarm-
° teplsfadb™: errer=2, Mon hai tal ficheire ou directorio” while attemp Ling Lo get
adb version from “fopt/android-sdidinusfplatform-tooksfadb’

Na versién de Ubuntu de 13.10 de 64bits aparecen varios erros que fan mencién 0 problema que se tifia antes co compofiente ADB. Este
servizo é lanzado polo plugin ADT para poder usarse no DDMS como se vera mais tarde.

- “adb wersion’ Failed!
e foptfandroid-sdkdine/platform-toolsfadb: error while loading shared
libraries: libsbdce+,50.8: cannok open shared object file: No such file or
directory

... aqui indica que precisa unha libraria que non ten.

Jawa EE - Eclipse

s | & weloome lt
il Eclipse Jav DE for Web Developers

Duerwvlew

Entramos igualmente en Eclipse ...
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s Lt = I R R o N AR, ] -
& 3 o i * s EE
o= - o T -] -

i analing i5 il vailabhe
& Coraake 3 - B

= k& 8-

COME
DA13-18-71 1319948 afs | Urexpected exceptaon ‘Carmat ren grogram ot mred ro Ld - sl - |
(2131821 13195 aia] Urecpected exception “Carnat ren grogram aptsandrold-sdk-1

E vemos dous erros na parte inferior avisando do mesmo.

1.7 Librarias de 32 bits precisas para Ubuntu 13.10 Linux de 64 bits

¢ Se o lector esta usando unha version de Ubuntu de 32 bits xa pode pasar ao seguinte punto.

e Como se viu antes o SDK de Android era valido para as versions de 32bits e 64bits, pero se estamos nun SO de 64 bits, este non ten
instaladas algunhas librarias de 32 bits que precisan algins compoiientes do SDK, por exemplo o ADB.

¢ O Android Debug Bridge (ADB) é un comando que arranca un servidor que nos vai permitir comunicarnos e interactuar cos dispositivos
fisicos ou emulados.

¢ O ADB verase con profundidade nun apartado posterior, por agora so interesa que se poida executar.

¢ No enlace hai mais informacion: http://developer.android.com/tools/help/adb.html

. nstalacién libraria 32 bits

ladmindubase: ~

IEEI IR EER R opt fandrold-sdk-11 latforn-tools/ad
fopt/androld-sdk-linux/platform-tools/add: error while loading shared libraries:
libstdce+.50.6: cannot open shared object file: No such file or directory

Ladningubase:-$

Este compofiente atépase na ruta do SDK en: /opt/android-sdk-linux/platform-tools/adb. Ao executalo vese que nos indica un erro cunha
libraria.

ladmin@ubase; =

Ladmingubase: -5 sude apt-get install [RYER
Lende as listas de paquetes... Feito
onstrulndo a arbore de dependencilas
Lenda & Lnformacion do estado... Felto

s seguintes paguetes WOVODS hanse instalar:
Lib3Z2stdc++6
B anovades, 1 instalades, Vanse retirar 8 e deixar 14 sen angvar,

Instalamos a libraria, pero de 32 bits, como root: sudo apt-get install lib32stdc++6
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L] T
Ladei ngusane; -5

Jndrold Gebey Bridge verslos 1.

a
-d
-,

5 <upecific devices

p spreduct name or paths

H
-F

devlces [-L]

CcomEct shefte] uparte]

disconmect [shests[taparts]]

Hevice commande:
oy push <locEls =remstes
mil pull wremster |[<lecals]
oy sy [ sdirectorys ]

o

a1

adk to liscen o0 all isterfaces Tor a cennecilon
command to the only connected UGN cewice

an errer LF more than oane VB Ssvice 15 present.
coreand to the enly rusaing emulator,

returns an errer 1 more Than one emulator 1s running.
directs comeand to the device or eewlator with the glwen
serlal nusber of gualifier. Owercides ARDROLD_SERLEL
envirorrent variabls,

simgle prodect name 1ike 'sooner', or

a relativefabrolute path $o a prodect

oul directery Uike "out)target /prosict /soomnsr ' .

I¥ -p &3 nat specified, the ANCROID PROHICT_DHIT
emvlroseent varlable is used, which must

be an sEzolute path.

Hame of adb server Rost [default: Localhast)

Port of adb server [default: ST}

1ist all ceanected devices

£'-1° will ales List device qualifisrs)

comect to & devlce via TORJIP

Port 5555 4x used by default AF no port nueBer is specified.
disconsect from a TEPJIP device.

Port 5555 tx used by default AF no port nusBer ix specifisd.
ustng thiz command with no sddltlonsl &rgusents

will discomnect frem all connected TCOP/IP devices.

directs
directs
FELETnE
directs

copy Fllefdlr o device
copy filefdir from device
copy bt sdevice saly LT changed

-1 meanz Limg But don't copy)
{zee 'wmib belp all®)

run rescte shell intersctively
run remste shell cormand

md whall
oy shell

Executamos de novo o comando: /opt/android-sdk-linux/platform-tools/adb e xa amosa a axuda do comando.

O Nl

¢ Agora xa podemos iniciar Eclipse que non se tera ninglin problema co ADB nunha version linux de 64 bits.
¢ Ainda hai que instalar algunha libraria mais de 32 bits, pero imos esperar a que xurda o erro.

1.8 Configuracion Eclipse e plugin ADT. Actualizacions

¢ Agora xa podemos iniciar eclipse sen problemas e imos ver:
+ Parametros de configuracion de Eclipse.
+ Como actualizar Eclipse ou o SDK de Android.
+ Que elementos engadiu o plugin ADT & Perspectiva Java de Eclipse.
¢ Unha Perspectiva é unha combinacién de pantallas para facilitar o desenvolvemento de aplicaciéns de distintos tipos.
¢ Aconséllase que se lle bote un ollo a: "Mi primera hora con Eclipse™:
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

e Preferencias
Java EE - Eclipse

- W Whindow rQ -
Hide Toolbar
Bproject Explorer 8| = 0O Open Perspective '

Sheow View k

; Cusbomize Perspective...
Save Perspective As..,
Reset Perspeckive...
Close Perspective

Close All Perspectives
Mawvigation :

Web Browser '

[ prererences | |

Premer en Window -> Preferences.
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]
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* Help
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¥

Java

* Appeasrance
® Build Path
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Compiler
Darkiug

Editor
Installed JREs
JuUnit

[
L
"
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A versién do compilador JDK que vai usar o IDE.

Installed JRES

Add, remaove or edit BE definitions. By default, the checked ME iy addes
path of reswly Created dava poojects
irstalled JREs:

[ ETiet] Leatian
¥ = Java-T-open)|dk-amdtd {def fusriibfvmfJava-T-open|dk-amdi

Er

A version do JRE

¢ Actualizacions

Project Explorer i

e a sla ruta.

Welkiame
Heln Contents
Search
= ™ Cymamic Help
= Key Assisk...

Tips and Tricks
Rpart B of ERtancem e
Chaal Shaels

Eclipte Marketplace...

Chatck for Updates

inmstall M Sofwa e

Aboak Eclipse

esta preferencia xa se poderia configurar.

Hai que lanzar o Eclipse como root (sudo /opt/eclipse/eclipse). En Help -> Check for Updates.
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nbacting 5

6 Checking for updabes

Always run in background
Contacting Software Sites

Checking for updates..:

Cancel ==Dekalls | Rur in Backgrourd

Comprobando se hai actualizacions do IDE.

0 Mo updates ware M'ound.

Non hai actualizacions.

¢ Perspectiva Java

. Jmva EE - tlardu i laMundo. java - Eclipse
i W b - T v B AL
I:_'. k ¥ T J rI‘lI

- ., iF Hew Windaw LR B I

Hide Toolbar

Praject Explorer | = 0O
S Wiew

2}

Customize Perspective..,

Cawe Perdpective Ad_. Resource
Reset Perspective i 2
Close Perspective Qthaer...,

Cloge All Perspectives
Havigathon ¥

Web Browser L
Prefarences

Pero ADT instalou comporfientes na Perspectiva Java. Premer en Window -> Open Perspective -> Java
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Aparecen novas iconas, entre elas, o Android SDK Manager e o Xestor de Dispositivos Virtuais.
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Dende o propio Eclipse, o plugin proporciona un enlace ao comando que chama ao Xestor de SDK de Android, que estaba na ruta:
/opt/android-sdk-linux/tools/android sdk. Dende aqui poderianse instalar/desinstalar compofientes e incluso actualizalos. Pero hai que
iniciar o Eclipse como root: sudo /opt/eclipse/eclipse. Non o pode facer un usuario normal (ben, salvo que en /opt/android-sdk-linux se lle
dean permisos de escritura a todo o0 mundo).

1.9 Carpetas de traballo

¢ As carpetas que se obtefien finalmente pertencen a 2 tipos:
+ Carpetas de programas:
O /opt/eclipse: Eclipse + plugin ADT
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¢ /opt/android-sdk-linux: Android SDK
+ Carpetas de configuracion de usuario
¢ /home usuario/.eclipse: Carpeta oculta. Contén arquivos de configuracién relativos a ese usuario e ao IDE Eclipse.
¢ /ruta/workspace: Carpeta indicada polo usuario onde se van gardar os proxectos creados no IDE Eclipse.
¢ /home usuario/.android: Carpeta oculta. Contén arquivos de configuracién relativos ao SDK de Android e onde se van
gardar os emuladores de dispositivos mébiles (AVDs) que cree o usuario.

¢ Dende a sesién do usuario co que se estaba no sistema se estivo executando Eclipse e o SDK de Android como root, aconsellamos, para
que non haxa problemas con permisos, que se borren as tres carpetas asociadas & configuraciéon do usuario. Puidera ser o caso de que xa
non existiran esa carpetas, pero é mellor asegurarse.

ladmin@ubase; -

ladmin@ubase:-% sudo rm .android -r

rm: non se pode eliminar ".android": Non hal tal ficheiro ou directorio
ladmin@ubase:~5

Ladmin@ubase:~% sudo rm .eclipse -r

rm: non se pode eliminar ".eclipse”: Non hail tal ficheiro ouw directorio
ladmin@ubase:~5

ladmin@ubase:~5 sudo rm workspace/ -r

ladmin@ubase:~5

1.10 Fixar a icona ao Lanzador

¢ Unha forma de facilitar o acceso a eclipse pode ser fixando a icona ao Lanzador.
¢ Hai varias formas de facelo, unha delas é a seguinte, unha vez que se ten o localizado na Lente de Incio, arrastralo ate a barra do Lanzador.

e Fixar icona ao Lanzador

& - 0 u1310-base (antes adb) [Runnin

8- \ ® eclip

Eii Aplicativos
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Eclipse

-- Angel D. Fernandez Gonzalez e Carlos Carrion Alvarez -- (2015).
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